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1 Introduction 
 

This user manual details how to use IRISYS Report Writer. IRISYS Report Writer has 

been produced by IRISYS for people who are required to submit a report after 

performing a thermography inspection survey with an IRISYS thermal imager. It 

simplifies the process of combining the following into a thermography inspection 

report: 
 

1. thermal images, 

2. information that is required to assess the condition of a target object, 

3. visual images if required. 
 

1.1 You Will Need: 
 

1. The IRISYS Report Writer Software – included on the CD. 

2. IRISYS Thermal Snapshot files (.snp), taken using an IRISYS 1000 or 1020 

series imager – see your IRISYS imager user manual for details on how to take 

thermal snapshots, and how to transfer them to a PC.  

3. Visual images from a digital camera (although not required, these can aid the 

understanding of a thermography inspection, and can be included if relevant). 
 

The IRISYS Report Writer Software produces report files in Adobe .pdf format. In order 

to print and view a file in Adobe PDF format, you first need to have the free Adobe 

Acrobat Reader installed on your computer. 

You can download the free Adobe Acrobat Reader from Adobe's Web site: 
http://www.adobe.com/products/acrobat/readstep2.html  

For Adobe Reader support: 

http://www.adobe.com/support/products/acrreader.html 

 
 

1.2 End Result: 
 

The IRISYS Report Writer creates a thermography inspection report in .pdf format. The 

report can include a company logo, an automatically generated contents page, general 

information about the thermographic survey, thermal snapshots and visual images, 

specific information about each thermal snapshot and finally an automatically 

generated report summary. The contents page is useful if many inspections are 

included in the report, and the summary can be used to plan a maintenance schedule 

as repair priorities can be displayed. 
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2 Quick Report Generation 
 

1. Install IRISYS Report Writer onto the PC. See Section 3.3 for more details. 
 

2. Launch IRISYS Report Writer from the desktop. See Section 4.1 for more details. 
 

3. The “Title Page” tab opens as default. Use this tab to enter general information about 

the thermography inspection report.  See Section 4.3 for more details. 
 

4. Select the “Image Select” tab. Use this tab to select the thermal snapshots and visual 

images that will be included as “inspections” in the thermography inspection report. See 

Section 4.4 for more details. 
 

5. Select the “Inspection Data” tab. Use this tab to add specific information about individual 

inspections. Select “Next” or “Previous” to add information about other inspections in the 

report. See Section 4.5 for more details. 
 

6. Click “Generate Report” to create the thermography inspection report now, or select 

“Save” or “Save As…” from the file menu to complete the report at a later date. See 

Section 4.7 for more information. 
 

7. The report opens in Adobe Acrobat Reader (if installed). Print the thermography 

inspection report from this window. See Sections 5 & 6 for more information. 
 

3 Installation 
 

3.1 Contents of the Report Writer Package 
 

The package includes a CD-Rom, which contains the software and user manual. 
 

3.2 PC System Requirements 
 

The PC should be IBM compatible running MS Windows XP or 2000, with the free 

Adobe Acrobat Reader installed.  
 

3.3 Installation of software onto PC 
 

The software is on the supplied CD-Rom. 
 

1. Insert the “IRISYS Report Writer” CD-Rom into the PCs CD-Drive. 

2. Double click on ‘My Computer’ and then on the CD-Drive. 

3. Double click on ‘1000 Series Report Writer Setup.exe’. 

4. Follow the on screen prompts to complete the installation. 
 

Note: The IRISYS Report Writer software will be installed by default into the following 

path: 

 

 C:\Program Files\IRISYS\1000 Series Report Writer 

 

The above path and name can be changed during the installation, but it is advisable to 

leave it as the default. The installation will also put a ‘Shortcut Icon’ onto the PCs 

desktop to allow quick and easy start-up of the software. 
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4 Using Report Writer 
 

4.1  Launching the Software 
 

Launch the IRISYS Report Writer program from the Desktop icon,  

 

 

Figure 1: Report Writer Desktop Icon 

Or from: 

 

START/PROGRAMS/IRISYS/IRISYS 1000 Series Report Writer. 

 

 
 

Figure 2: Report Writer Start Menu Location. 
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4.2 Introduction to Operation 
 

The Report Writer software is used to create one “thermography inspection report”, 

which contains one or more itemized reports (each including one thermal snapshot) 

called “inspections”.  
 

When launched, the window obtained will be similar to Figure 3. 

 

The software has a toolbar with “File”, “Tools” and “Help” options, the functions of 

which are described in Section 4.7. It also has “Title Page”, “Image Select” and 

“Inspection Data” tabs which are selected by clicking on the tab labels. These tabs are 

used to input general information into the thermography inspection report and to 

create a number of “inspections”. When the software is launched, the “Title Page” tab 

is selected by default.  
 

4.3 Title Page Tab 
 

 

 

Figure 3: Report Writer Title Page Tab. 
 

This tab is used to add the following information to the header of the thermography 

inspection report: 

 

1. Company Logo (Section 4.3.1). 

2. Company or Client Name (Section 4.3.2). 

3. Author (Section 4.3.3). 
4. Date (Section 4.3.4). 
5. General Comments (Section 4.3.5). 
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4.3.1 Company Logo 
 

If desired, click “Set Image” to insert a company logo into the image frame at the 

top of the thermography inspection report’s title page. The “Set Image” button 

opens a search window that displays the Windows folder structure and .bmp & .jpg 

files only, as these are the image file types that can be imported. Once selected, 

images can be removed by selecting a new image, or by clicking “Clear Image”. 
 

Note: When Report Writer opens, the logo last used is selected by default. 
 

4.3.2 Company or Client Name 
 

This is the name of the company whose site is being surveyed. After entering the 

company name, it becomes the default company name when the software is 

restarted. 
 

4.3.3 Author 
 

This is the name of the thermography inspection report author. Note that camera 

operator’s names can be entered separately in Section 4.5.3. The Authors’ name 

will persist when the software is restarted. 
 

4.3.4 Date 
 

The default is to display today’s date. Select whether or not to display the date of 

thermography inspection report generation by clicking on the radio buttons. If the 

default is not correct click on the list box and the calendar will appear as shown in 

Figure 4.  

 

 
 

Figure 4: Select the Date From The Calendar. 

Note: When loading previously saved .TIR files, the original date remains and is not 

overwritten by today’s date. 
 

4.3.5 General Comments  
 

Comments can be added to assist with the understanding of the thermography 

inspection report when read at a later date. Typical examples include company 

visited, site location, contact details of site manager, initial reason for site visit etc. 
 

When all the appropriate information has been added to the thermography 

inspection report, click on the “Image Select” tab. It is possible to return to the 

“Title Page” tab to edit this information at any time before the .pdf report is 

generated. 
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4.4 Image Select Tab 
 

This tab (see Figure 5) is used to select which thermal snapshots (file extension .snp) 

are to be added to the thermography inspection report. Please see the imager user 

manual for information on how to download thermal snapshots from a handheld device 

to a PC. This page is also used to match up these thermal snapshots with any related 

digital camera visual images. 

 

 

 

Figure 5: Report Writer Image Select Tab. 

 

The following sections give a detailed description of how to: 

 

1. Search for a folder of thermal snapshots to open (Section 4.4.1). 

 

2. Add the required thermal snapshots to the report (Section 4.4.2). 

 

3. Search for a folder of visual images (Section 4.4.3). 

 

4. Insert the required visual images into the report, and associate them with 

thermal snapshots already in the report (Section 4.4.4). 
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4.4.1 Thermal Snapshot Folder Search 
 

To find a folder containing thermal snapshots: 
 

• Click “Browse” on the left hand side of the page and search for the required 

snapshot folder using a standard search window. Only folders and .snp files 

will be displayed.  

 

 

Figure 6: Thermal Snapshot Folder Search 
 

To open a folder of thermal snapshots: 
 

• Either double-click a thermal snapshot within the required folder, or single 

click one and then press “Open”. 
 

 

Figure 7: Opening a Thermal Snapshot Folder 
 

Note: A snapshot must be selected to load the snapshot folder. 
 

• Alternatively if the location of the saved thermal snapshots is known, the 

folder path can be typed into the text box labelled “Snapshot Folder” and 

then “Refresh” can be clicked.  
 

 

Figure 8: Opening a Thermal Snapshot Folder 
 

All the thermal snapshots in the selected folder will appear as thumbnail snapshots 

in the frame below the “Browse” and “Refresh” buttons as shown In Figure 5.  If 

there are more thumbnails to display than the available space permits, a scrollbar 

appears beside the frame. 
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4.4.2 Thermal Snapshot Select 
 

To add a thermal snapshot from the selected “Snapshot Folder” to the 

thermography inspection report: 
 

• Click on a thermal snapshot thumbnail. This will make the thermal image 

appear in the preview frame at the bottom left-centre of the page. If the 

image is required in the report, click “Add”. TIP: simply double-click a 

thumbnail to add a thermal snapshot directly. This will make the snapshot 

thumbnail appear in the central column. 
 

 

Figure 9: Adding a Thermal Snapshot to the Report 
 

• If all of the thermal snapshots in the folder are required, click “Add All”. To 

remove thermal snapshots from the central column, first click on the 

thermal snapshot (which will highlight it in blue) and then click “Remove”. 

To remove all thermal snapshots, click “Remove All”.  
 

Notes:   
 

1. Repeat sections 4.4.1 and 4.4.2 if thermal snapshots are required from 

multiple thermal snapshot folders.  

2. Removing thermal snapshots from the thermography inspection report will 

also remove any associated visual images and any text you may have 

entered for this inspection in the “Inspection Data” Tab. 

3. The header of the central column of the “Image Select” tab displays how 

many “inspections” will be included in the report. 
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4.4.3 Visual Image Folder Search 
The same procedure is used to add visual images to the thermography inspection 

report.  To find a folder containing visual images: 

• Click the “Browse” button on the right hand side of the page to search for 

and open the folder required. Only folders, .bmp and .jpg files will be 

displayed.  

To open a visual image folder: 

• Double-click a visual image within the required folder, or single click one 

and press “Select”.  

• Alternatively type the path of the visual image folder into the text box on 

the right of the page and click “Refresh”.  

All the .jpg and .bmp files in the selected folder will appear as thumbnail visual 

images in the frame below the “Browse” and “Refresh” buttons as shown in Figure 

5.  If there are more thumbnail visual images to display than the available space 

permits, a scrollbar appears beside the frame. 
 

4.4.4 Visual Image Select 
To add a visual image from the selected “Image Folder” to the thermography 

inspection report: 
 

• Click on the thermal snapshot in the central column to which the visual 

image is related by clicking on it. This will highlight it in blue and also make 

it appear in the preview frame at the bottom left-centre of the page.  
 

 

Figure 10: Highlighted Thermal Snapshot 

• Click on a thumbnail visual image to see the image preview in the bottom 

right-centre of the page. Click “Add” if it matches the previewed thermal 

snapshot in the bottom left-centre of the page. TIP: simply double-click a 

thumbnail visual image to add it directly.  

• If all of the visual images in the folder are required and the images are in 

the same order as the thermal snapshots, highlight the first thermal 

snapshot in the central column and click “Add All”.  

• To remove visual images from the central column, first click on the visual 

image and then click “Remove”. To remove all visual images, click “Remove 

All”.  

Notes:  

1. Repeat sections 4.4.3 and 4.4.4 if visual images are required from multiple 

visual image folders. 

2. If visual images are to be added to the thermography inspection report, they 

must be added to thermal snapshots already in the central column of the 

“Image Select” tab. 

3. After the required thermal snapshots have all been added to the thermography 

inspection report (and matched with visual images where relevant) click on the 

“Inspection Data” tab. It is possible to return to the “Image Select” tab to enter 

more inspections at any time before the .pdf report is generated. 
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4.5 Inspection Data Tab 
 

This tab (see Figure 11) is used to enter information specific to each thermal snapshot. 

The tab generates a one page “inspection” per thermal snapshot. To cycle through the 

inspections, click “Previous” or “Next” at the top of the page. If 3 thermal snapshots 

have been entered on the “image Select” tab, the page will initially display inspection 1 

of 3. The information that can be entered is listed below: 
 

Line Drawing (Section 4.5.1). 

Inspection Name (Section 4.5.2). 

Operator (Section 4.5.3).  

Location (Section 4.5.4). 

Equipment (Section 4.5.5). 

Comment (Section 4.5.6). 

Load (Section 4.5.7). 

Temperature Measurement Information (Section 4.5.8). 

Repair Priority (Section 4.5.9). 

Fault / Recommended Action (Section 4.5.10). 

Inspection, Repair & Re-inspection Dates (Section 4.5.11).  

 

 
 

 

Figure 11: Report Writer Inspection Data Tab. 
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4.5.1 Line Drawing 
 

The software has the ability to draw lines onto the thermal snapshot (and visual 

image if available) to help the reader of the report to identify the points of interest. 

For example in Figure 12 below, the hot breaker has been identified in both the 

thermal snapshot and the visual image.  

 

Figure 12: Drawing Lines to Identify Hotspots. 

This is done on the “Inspection Data” tab by clicking on part of the combined visual 

and thermal image to create one end of the line, and then by clicking elsewhere in 

the image to create the other end of the line. The controls for drawing lines are 

shown in Figure 13. The line thickness can be adjusted by selecting a number 

between 1 and 9 from the “Pen Size” list box, and the colour of the line can be 

adjusted by clicking “Change”, and selecting a colour from the popup palette. 

Clicking “Undo” removes drawn lines one at a time or all the lines can be removed 

by clicking “Clear”. 
 

 

 

Figure 13: Line Drawing Controls. 

4.5.2 Inspection Name 
The inspection name appears in the contents page of the thermography inspection 

report, and therefore it is recommended that the inspection name includes enough 

information to identify the thermal snapshot. 
 

4.5.3 Operator 
This is the camera operator’s name (for this inspection). Note that the software 

allows an individual entry for each inspection, allowing inspections from different 

operators to be included in the thermography inspection report. Also note that the 

report author is entered separately (see Section 4.3.3). 
 

4.5.4 Location 
This is the inspection location, such as site name, building name, floor number or 

area. 
 

4.5.5 Equipment 
Description of equipment, for example “fan motor” or “main breaker panel”. 

 

4.5.6 Comment 
This is for comments specific to the equipment and snapshot. For example, detailed 

location information, tools required for access, access time limitations etc. 
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4.5.7 Load 
Measured and rated load on equipment, and measured load as a percentage of 

rated. Load can include current and voltage measurements, rotation speeds, 

weights lifted etc. 
 

4.5.8 Temperature Measurement Information 
Depending on how many pixels are selected in the thermal snapshot, up to two 

colour coded temperature measurements can be displayed here. The emissivity and 

ambient temperature values are also included so it is possible to make an accurate 

evaluation of the temperature of the target(s).  
 

4.5.9 Repair Priority 
Repair priority (1 low to 5 high) can be added to indicate the severity of the fault. 

This appears in the thermography inspection report summary and can be used as 

part of a continuous maintenance program or for a one-off inspection. 
 

4.5.10 Fault / Recommended Action 
Description of the fault found, and details of recommended action. This section can 

also be used to explain the repair priority given above. 
 

4.5.11 Inspection, Repair & Re-inspection Dates 
The date and name of operator for inspection repair and re-inspection can be 

included. Note that thermography inspection reports can be saved (see File menu 

commands in section 4.7) after initial inspection and reopened at a later date to fill 

in date of repair and re-inspection, and information about the repair can be added 

to the “Fault / Recommended Action” text box. 
 

When the information for this inspection has been correctly entered, click “Next” at 

the top of the page to fill in data for other inspections in the same manner. When 

this is finished there are three saving options. 
 

4.6 Generate or Save? 
1. If the thermography inspection report is ready for printing, select “Save” or 

“Save As” from the “File” menu on the toolbar to save the report information as 

a .TIR file. This enables you to return to edit the report at a later date if 

required. See Section 4.7 for more information. Now click “Generate Report” at 

the bottom of the “Inspection Data” tab. This will open a “Save As” window to 

save the thermography inspection report in .pdf format.  
 

2. Note: It is not possible to return to edit the report (including repair and re-
inspection details) unless it is saved as a .TIR first.  

 

3. If more report information needs to be added at a later date, select “Save” or 

“Save As” from the “File” menu on the toolbar to save the thermography 

inspection report in progress as a .TIR file. See Section 4.7 for more 

information. 
 

4. If more information or snapshots need to be added to the report now, it is 

possible to reselect the “Title Page” or “Image Select” tabs as required. 
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4.7 Toolbar 
 The File menu allows the following: 

 

• New – Opens a blank Report Writer window. 

• Open… – Opens a search window so existing .TIR files can be found and 

opened. 

• Save - Opens a “Save As” window to save a report as a .TIR file with the 

same name. 

• Save As… - Opens a “Save As” window to save a report as a .TIR file with a 

new name. 

• Recently opened .TIR files will be listed here. 

• Exit – Exits the IRISYS Report Writer program. 

Note: The .pdf thermography inspection report cannot be edited, so it is 

recommended to save the report information as a .TIR file before closing Report 

Writer. 

 

The Tools menu allows the following: 

• Language – Allows the user to change the language of the user interface 

and reports generated. Note this setting is persisted when the program is 

restarted. 

 

The Help menu displays information about the program, including the software 

version number. 
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5 Sample Thermography Inspection Report 
 

The thermography inspection report is saved in .pdf format. 

 

5.1.1 Title Page 
 

The first page of the thermography inspection report shows a company logo if 

required and is titled “Thermography Inspection Report”. The information previously 

entered on the “Title Page” tab (Company, Author, Date, and General Comments) 

appears here. 

 

 

 
 

 

 

Company IRISYS 

Author A N Other 

Date  17th August 2005 

  
   

General Comments 

Company visited: IRISYS 

Site location, Swan Valley 

Contact details of site manager:  A N Other, 01604 594200 

Initial reason for site visit: Routine maintenance interval. 
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5.1.2 Contents Page 
 

The second page is an automatically generated contents page, detailing which 

inspection appears on which page of the thermography inspection report. It also gives 

the page number of an automated thermography inspection report summary. 
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5.1.3 Inspections 
 

There are then X pages of inspections where X is the number of thermal snapshots 

included in the thermography inspection report. Each inspection shows all of the 

information entered during the “Inspection Data” stage, and they also show some 

information gathered from the thermal snapshot file:  
 

1. Up to two colour-coded, temperature measurement pixels are highlighted on the 

thermal snapshot. 

2. Either one pixel temperature measurement, or two pixel temperature 

measurements and the difference in temperature between the two are shown 

below the thermal snapshot. 

3. The date and time that the snapshot was taken.  
 

Note: The time and date information comes from the Imager, PC or Pocket PC the 

snapshot was saved on, and if these settings are not set correctly, then the time will 

not be correct in the snapshot file.  

 

4. The emissivity and reference ambient temperature, as entered into the Imager or 

imager software.  
 

Note: If these details are incorrect, the snapshot properties can still be altered using 

the imaging software.  
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5.1.4 Report Summary 
 

At the end of the thermography inspection report there is an automatically generated 

report summary that gives the following details about each inspection: 

 

1. Inspection number, which is taken from the order the thermal snapshots were 

entered. 

2. Location,  
3. Equipment,  

4. Fault / action  
5. Priority (1 Low, 5 High). 

 

This summary makes it easy to plan a maintenance schedule using the priority values 

given for each inspection.  
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6 Printing 
 

The thermography inspection report is now complete and can usually be printed by 

selecting “Print” from Adobe Acrobat Reader “File” menu on the toolbar. As an alternative 

to printing, the .pdf file can be emailed to a customer or client. 
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7 Customer Feedback Form 
 

If you have any feedback or have had any technical issues with an IRISYS Thermal 

Imager or the Report Writer software, please complete the details below and send it 

back to IRISYS at the address on the front page of this manual.   

 

 

Name: 

 
 

Company name and address: 
 
 

 
 

Contact details: 
 

 
 
 

Thermal Imager part number and serial number: 
 

 
 
 

Imaging software version installed: 
 

 
 
 

Report Writer software version installed: 
 

 
 
 

Description of technical fault/feedback: 
 

 


